Read Me

Pro Tools HD 10.1 on Mac OS X 10.7.x (“Lion”)

This Read Me documents important compatibility information and known issues for Pro Tools HD 10.1 software with Avid HDX
hardware acceleration on computers running Mac 0S X 10.7.x (“Lion”)

Compatibility
Avid can only assure compatibility and provide support for qualified hardware and software configurations.

(¥ For the latest compatibility information—including qualified computers, operating systems, and third-party products—visit
the Avid website (www.avid.com/compatibility).

All Pro Tools Systems

An iLok must be connected at all times while running Pro Tools

Pro Tools requires that an iLok with the appropriate authorizations be connected to the computer at all times. Do not remove the
iLok while running Pro Tools. If the iLok is removed while Pro Tools is running, one of the following will occur:

Pro Tools shows a dialog giving you the following choices:
» Reinsert the iLok and click Save. Pro Tools saves the session and then quits.
« Click Quit. Pro Tools closes the session without saving and then quits.

— or —

Pro Tools displays a dialog giving you the following choices:
» Reinsert the iLok and click OK to continue working in Pro Tools.

« Click Cancel. Pro Tools closes the session without saving and then quits.

Mixer and Elastic Audio Plug-ins from lower versions of Pro Tools are not compatible with Pro Tools 10 (PTSW-136983)

The Mixer and Elastic Audio Plug-ins from lower versions of Pro Tools are not compatible with Pro Tools 10.0. If you encounter
an error indicating that these plug-ins are corrupted please re-run the Pro Tools 10 installer to ensure that the correct plug-ins
are installed.

Pro Tools cannot record to drives formatted as Case-Sensitive (PTSW-64502)

Pro Tools cannot record to Mac OS X drives which have been formatted as “Case-Sensitive.” Format the Mac OS X record volumes
as “Mac OS X Extended (Journaled)” in order to record properly.

Spotlight indexing can interfere with long record passes (97151)

There are known incompatibilities with Spotlight indexing drives while recording audio. If you will be recording to a large num-
ber of tracks for over an hour, set all of your drives to private in the Mac OS X System Preferences to ensure maximum perfor-
mance. Failure to do this may result in Pro Tools reporting an error and ending the record pass when Spotlight indexes the drives.
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Mac OS X 10.7.x Keyboard Shortcuts for Mission Control Conflict with Pro Tools Keyboard Shortcuts

By default, Mac OS X 10.7.x uses Control + Arrow Up and Arrow Down keys to open Mission Control and Application Windows.
These keyboard shortcuts conflict with the Pro Tools keyboard shortcuts for changing track display height. You can disable or re-
assign these shortcuts in Mac OS X.

To disable or reassign keyboard shortcuts in Mac OS X:
1 From the Apple menu, choose System Preferences.
2 Click Keyboard.

3 Click the Keyboard Shortcuts tab.

4 Disable or reassign the shortcut for Mission Control.

In Mac OS X 10.7.x, the Library folder in each User folder is now hidden

DigiTrace logs, which can be helpful in troubleshooting Pro Tools errors, are stored in User/Library. These logs will be more dif-
ficult to find if the Library folder is hidden.

To find the Library folder:

= Go to the Finder and click the Go menu while holding the Option key. Library will appear in the menu while the Option key is
held.

To display all hidden files and folders in an Open dialog:

= Press Command+Shift.
To permanently unhide the Library folder:
1 Launch Terminal.

2 Type: chflags nohidden /Users/<Username>/Library.
Q The hide status of the Library folder may be reset during an OS update.

Pro Tools Menus and Interface are Grayed Out on Launch (PTSW-18024)

Pro Tools can appear unresponsive at launch, with the Menus grayed out and browsers inoperable. This can happen because of
Spaces. If Pro Tools is launched in any other Space than the first one, the Session Quick Start dialog still opens in the first Space.
You can temporarily disable Spaces, launch Pro Tools, and disable the Session Quick Start dialog in the Preferences to avoid this
problem.

Automatic Update Notification will not connect through a proxy server that requires authentication (108837)

Software Updater will not find an active internet connection when behind a proxy server that requires authentication to gain in-
ternet access. To work around this, the client machine with Software Updater needs to be moved out from behind the proxy or
the proxy needs to allow HTTP access via port 80 without requiring authentication.

Ethernet control surfaces may be unable to communicate with Pro Tools when Parallels Desktop for Mac is Installed (101232)

If you use an Ethernet control surface (such as C|24) or work surface (such as D-Control or D-Command) with Pro Tools,
Parallels Desktop for Mac may prevent communication with the surface. Uninstall Parallels for your computer to restore
communication.
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HDX Hardware Accelerated Systems
Some MacPro Computers with Certain Video Cards May Not Have Power Connections Available for HDX Cards (PTSW-156651)

Some video cards require power from the motherboard, which is also a requirement for Avid HDX cards. If you have a video card
that requires both power connections on the motherboard, a power connection for your HDX cards will not be available. To avoid
this problem, use a video card that does not require more than one power connection to the motherboard.

In Avid DigiTest, the Reported Slot Number May not Correspond to the Physical Slot Number in the Computer (PTSW-155373)

In Avid DigiTest, the slot number reported for Avid HDX cards starts from 0 on up. For example, “Slot 1” does not necessarily
correlate to the first physical slot in the machine. If you have an Avid HDX card that is having problems, match the Serial Number
ID on the back of the card with the Serial Number ID displayed on the Slot Info page in Avid DigiTest.

Known Issues

The following section documents known issues you may encounter when using Pro Tools Pro Tools HD 10.1, along with work-
arounds if they exist.

For known issues specific to any of the software options for Pro Tools HD, see the Satellite Link Read Me, the Video Satellite
Read Me, or the Video Satellite LE Read Me.

General Pro Tools Issues
Playback of QuickTime video in Pro Tools may stutter or drop frames
When monitoring QuickTime playback in the Pro Tools Video Window on the computer screen, the video image may stutter or
drop frames. To improve results with QuickTime playback, try any of the following:
« Disable Continuous Scrolling.
« Close unnecessary UI windows.
o Try using the DNxHD codec.
« If you have an available PCle slot in your computer, try using one of the following:
+ A supported Blackmagic video card
+ A supported Canopus video peripheral for QuickTime DV playback
o Consider using an Avid option that includes a video solution:
« The Video Satellite option offers guaranteed performance for Avid video playback (QuickTime can also be used via AMA).
« The Video Satellite LE option offers a way to integrate a Blackmagic video card into a system

« The Avid Mojo SDI peripheral offers guaranteed performance for standard-definition Avid video

Synchronizing to External Clock with a Different Sample Rate from the Session Results in the Following Error: “The current
playback engine does not support a sample rate of 44.1 kHz" (PTSW-127065)

In certain circumstances, attempting to synchronize to an external clock that has a different sample rate than the session may re-
sult in the following error: “The current playback engine does not support a sample rate of 44.1 kHz.” On Mac OS X, this may be
preceded by the error “Pro Tools has re-set the sample rate of the HW device because it was changed by another application.” If
this happens, correct the sample rate mismatch and re-select the correct clock rate.

Templates Retain I/0 Settings and Some Preferences, Display Settings, and Window Layouts (PTSW-47133)

Pro Tools Session Templates Retain the I/O settings and some of the preferences, display settings, and window layouts from the
system on which the template was created. Consequently, created a new session based on a template restores several session prop-
erties from the original system. These properties are retained by Pro Tools until you change them or another session or template
is opened that replaces them. This also means that if a new blank session is created after using a template, the properties from
the template will be used for the new session.
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The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. You
can update templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install
template in system” option), and then selecting the template you want to replace.

On Mac OS X 10.7.x (Lion), installing the Pro Tools Instrument Expansion Pack after installing Pro Tools results in empty plug-in
list (PTSW-152505)

If you install the Pro Tools Instrument Expansion Pack (PTIEP) before installing Pro Tools on a system running Mac OS X 10.7.x
(Lion), no plug-ins will appear in the Pro Tools inserts menu. To avoid this, install Pro Tools first, then install the PTIEP. If you
installed the PTIEP first, you must uninstall both Pro Tools and the PTIEP, then reinstall Pro Tools first, followed by the PTIEP.

The Send To DigiDelivery Command in Pro Tools Does Not Work with Mac OS X 10.7.x (“Lion™).

The DigiDelivery client application requires Rosetta to be installed. Mac OS X 10.7.x does not support Rosetta.
Consequently, the Send to DigiDelivery command in Pro Tools is cannot be used on Mac OS X 10.7.x.

CPU Usage Limit May Be Reached when Error Suppression is Enabled (PTSW-50339)

When enabling Error Suppression at CPU Usage Limit 85% or higher, it may be possible to overload your computer to a point at
which it is no longer recoverable. To avoid this state, keep your CPU Usage Limit set to 80% or lower when Error Suppression is
enabled.

Screen Redraw May Slow Down at Higher CPU Usage Limit Settings when Host Engine Error Suppression is On (82915)

In some cases, you may experience a slowdown in screen redraw or background CPU tasks when Host Engine Error Suppression
is engaged and the CPU Usage Limit is set to 85 percent or above. If you encounter this behavior while using Error Suppression,
open the Playback Engine Dialog and lower the CPU Usage Limit by 5 to 10 percent.

Opening Session Created with Pro Tools 7.4 or Lower (106746)

When opening sessions created with Pro Tools 7.4 or lower in Pro Tools 8.1 and higher, all waveform overviews are recalculated.
This is because Pro Tools now features 16-bit waveform overviews, so all old 8-bit overviews will need to be recalculated. This re-
calculation only needs to happen once.

Save Session Copy to Session Formats Lower than Pro Tools 10 Converts All Audio for Sessions with Interleaved Files
(PTSW-152737)

When saving a Pro Tools 10.0 session that has a mix of interleaved and non-interleaved (multi-mono) audio files to a lower ses-
sion format (such as Pro Tools 7-9 “.ptf”), all audio files are converted (even if they are not interleaved).

Clip Groups can be Dragged to Tracks in Playlist View Even Through Clip Groups are not Supported in Playlist View
(PTSW-152707)

It is possible to drag a clip group to a track in Playlist view even though clip groups are not supported in Playlist view. Normally,
when switching to Playlist view from another track view, any clip groups on that track are automatically ungrouped. While clip
groups dragged to tracks in Playlist view may appear to work properly, it is recommended that you ungroup them while in Playlist
view to ensure proper behavior.

Automation is Replaced Instead of Overlaid when Using Adjust Session Start Time to Match Source Start Time when Importing
Session Data (PTSW-149273)

Automation can sometimes be replaced instead of overlaid when using Adjust Session Start Time to Match Source Start Time
when importing session data. This issue may occur if the source session start time (of the session being imported) is earlier than
the current session start time. This issue can be avoided if you instead import the session data from the session with the later start
time into the session with the earlier start time. You must also not enable the Adjust Session Start Time to Match Source Start
Time option, and select Maintain Absolute when prompted.

Automation Window Update when Writing Automation (PTSW-46747)

When writing automation on Volume, Pan, and so on, the corresponding buttons in the Automation window provide no indica-
tion that automation on the related control is being written. You will need to observe the automation buttons on tracks in Mix
or Edit windows to see an indication that automation is being written.
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Scrubbing Audio is Offset by the Overall System Delay when Automatic Delay Compensation is Enabled (PTSW-150138)

With Automation Delay Compensation enabled, when scrubbing audio the output is offset by the overall system delay (displayed
in the Session Setup Window). Large system delays cause a noticeable offset. To avoid this issue, you can disable Automatic Delay
Compensation when you want to scrub audio for editing.

Possible Performance Issues with Waveform Overviews (110041, 106801, and 106577)

Calculating waveform overviews in Pro Tools 8.1 and higher may cause some one time issues with various operations. Once the
overviews are calculated, system performance will return to normal. Areas where you may notice this are:

+ Legacy Sessions (110041)—When opening Legacy Pro Tools sessions (lower than 8.0) for the first time, if you immediately
start playback, you may encounter various errors advising you to increase the H/W Buffer size, or to delete tracks, or to re-
move some Native (RTAS and AAX) plug-ins. This is due to the fact that Pro Tools is re-calculating the session’s waveform
overviews in the background. Pausing this task in task manager, or waiting until this task is complete, will resolve the issue.
Once the waveform is calculated, you will not experience this issue again.

« Playback of Newly Created Clips (106801 and 106577)—You may notice a slight drop in normal playback performance im-
mediately following a record take or after creating or importing new clips. This is due to the fact that Pro Tools is calculating
waveform overviews in the background, and is mostly only encountered when recording or creating many clips with long du-
rations. Pausing this task in task manager, or waiting until this task is complete, will resolve the issue. Once the waveform is
calculated, your session playback performance will return to expected levels.

Waveform overviews disappear after editing metadata from the Workspace browser (PTSW-153258)

If you edit metadata from the Workspace browser, audio waveform overviews may disappear from the Edit window. If this occurs,
recalculate the waveforms or close and reopen the session. To avoid this issue, edit metadata from the Project browser instead of
the Workspace browser.

—9128 or —6031 DAE Errors when Using Sibelius 7 as a ReWire Client with Pro Tools (PTSW-148554 and PTSW-149809)

If you encounter -9128 or -6031 DAE Errors when using Sibelius 7 as a ReWire client with Pro Tools, try increasing the Hardware
Buffer Size to 1024 samples in the Pro Tools Playback Engine (Setup > Playback Engine).

Audio Clips on Tick-Based Tracks Do Not Play at the Correct Tempo after Opening a Reason Song with a Different Tempo
(PTSW-34086)

Audio clips on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different from
the one in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input and the clips
will play back correctly.

Cannot Run Reason or Record as ReWire Clients if They Have Not First Been Launched and Set Up as a Standalone Application
(PTSW-133070)

Reason and Record need to be launched and setup as a stand-alone applications before running them as a ReWire clients with
Pro Tools. Do the following:

o Launch Reason or Record in stand-alone mode and follow the on-screen instructions.

o Quit Reason or Record.

+ Launch Pro Tools and insert Reason or Record as a ReWire plug-in on an audio, Auxiliary Input, or Instrument track.

Exporting Interleaved BWF Files from Pro Tools 10 and Importing into Pro Tools 9.0.x and Lower May Cause Pro Tools to Quit
Unexpectedly (PTSW-151579)

When exporting any greater-than-stereo multichannel interleaved WAV (BWF) files other than 5.1 from Pro Tools 10 and then
importing them into Pro Tools 9.x or lower, Pro Tools quits unexpectedly. To avoid this problem, export audio files for import
into lower versions of Pro Tools in another file format (such as AIFF or multi-mono).
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Opening a Session with a QuickTime Movie as a Non-Administrator User Can Prevent the Movie from Playing Back (47053)

If you open a session as a non-administrator user and you do not have permissions for the QuickTime movie file, Pro Tools will
tell you that the movie file cannot be found and prompt you to relink. In the relink window the movie can be found and Pro Tools
will appear to relink to it but it will still not play back. For correct playback, make sure you have permission to use the QuickTime
movie file.

Some QuickTime Audio Formats Cannot Be Imported (58792 and PTSW-52226)

The audio from QuickTime movies with Apple Lossless or AMR audio compression cannot be imported into Pro Tools. Use Quick-
Time Pro or another application to convert the audio to another format prior to import.

Apple Lossless Codec Is Not Supported for Bounce to QuickTime Movie (PTSW-53198)

Pro Tools 7.3 and higher does not support the Apple Lossless audio codec. Choosing it from the Bounce to QuickTime Movie Au-
dio Compression dialog will result in a movie without usable audio.

48 kHz Bounce to MP3 in Pro Tools 7.x and Higher Results in a 44.1 kHz MP3 File (72617)

Bouncing to MP3 while using the “Highest Quality Encoding, Slower Encoding Time” setting with any bit rate other than 320 kbps
will result in a 44.1 kHz file. This is a known limitation of the encoder.

Changing the Genre Setting for the ID3 Tag Info when Bouncing to MP3 Results in an Error Message (PTSW-152856)

When bouncing to MP3, changing the Genre Info on the ID3 Tag more than once results in an error message. To resolve this issue,
close the error message, then close the MP3 window, and then click Bounce again.

Hourly —9073 Errors During Recording (PTSW-132654)

If you encounter -9073 disk errors at the same time every hour while recording in sessions with large track counts, you may need
to update Mac OS. To avoid this problem, check and install all OS related security updates through Mac Software Update.

With the Pro Tools Web Browser, Links to External Sites Do Not Work as Expected (PTSW-145325)

In the Pro Tools Web browser, navigating to external sites using links from Avid web pages (such as links to social networks like
Facebook and LinkedIn) may not work as expected. For the sake of security, the Pro Tools Web browser is restricted to avid.com
pages. If you want to browse sites other than avid.com, or share avid.com pages with friends, use the Launch Page in External
Browser feature to view the page in your default Web browser and navigate from there.

HDX Hardware Accelerated Systems
Pro Tools Does Not Play Back when an Invalid Sync Source is Selected on SYNC HD (Word Clock or AES/EBU) (PTSW-156651)

When attempting to initiate playback, playback will fail if a SYNC HD is connected to an HDX card and an Avid audio interface
with no connections to either the word clock or AES/EBU ports. Ensure that the clock is set to a working clock source to resolve
this issue.

Pro Tools Does Not Use HDX Hardware if a Core Audio Application is Using HDX Hardware (PTSW-155010)

When launching Pro Tools HD on an HDX hardware accelerated system, Pro Tools will use the Pro Tools Aggregate I/0 as the
Playback Engine if a Core Audio application has already engaged the HDX hardware. Be sure to quit all Core Audio applications
before launching Pro Tools HD to ensure that Pro Tools HD can use HDX hardware.

With Multiple Track Output Assignments, Native AAX Plug-ins Use More Voices than Expected (PTSW-156089)

When using Native RTAS or AAX plug-in as the last insert on a track that has multiple outputs assigned, additional voices will
be used for each voiced output assignment. This is because a voice is required for each audio channel routed from the TDM engine
to the host processor and back. To avoid this issue, use a DSP AAX plug-in, such Trim, as the last insert on the track.
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Some Audio Channels May Not Sound When Using Virtual Soundcheck with VENUE and Pro Tools HD with Avid HDX Hardware
(PTSW-155085)

Some channels may not sound from Pro Tools HD with HDX hardware when playing back using VENUE with the HDx option dur-
ing Virtual Soundcheck. This only occurs if you switch to Virtual Soundcheck when Pro Tools is running. To avoid this issue,
switch to Virtual Soundcheck on VENUE before launching Pro Tools. If you do encounter this issue, quit and relaunch Pro Tools
to correct the problem.

1/0 Setup
Session Templates Retain I/O Settings and Some Preferences, Display Settings, and Window Layouts (111605)

Pro Tools Session Templates retain the I/O settings and some of the preferences, display settings, and window layouts from the
system on which the template was created. Consequently, creating a new session based on a template restores several session
properties from the original system. These properties are retained by Pro Tools until you change them or another session or tem-
plate is opened that replaces them. This also means that if a new blank session is created after using a template, the properties
from the template will be used for the new session.

The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. You
can update templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install
template in system” option), and then selecting the template you want to replace.

Master Faders Assigned to Mapped Output Busses Function Only on that Specific Bus, Not for the Output Channel as a Whole
(PTSW-127517)

Because a Master Fader works on a bus, not on an output path or output channel, there may be certain configurations in which
the level sent to the physical I/0 is not reflected on any meters in the Pro Tools application. If the configuration includes over-
lapping output paths or has multiple busses assigned to a single output path, the overall signal level from these combined sources
(including any clipping indication) will only be displayed on the interface itself. You can avoid using multiple output paths or

output busses simultaneously by routing your sources to a single mapped output bus and assign a Master Fader to that.

Overlapping Outputs Are Not Supported for AFL/PFL (PTSW-128167)

While Pro Tools I/O Setup lets you select overlapping outputs for AFL/PFL monitoring, overlapping outputs are not supported for
AFL/PFL monitoring. For example, if paths A 3-4 overlap the main path A 1-2, even though you can select paths A 3-4 for
AFL/PFL monitoring, you won’t hear anything when monitoring AFL/PFL on paths A 3-4. You can avoid this problem by using
non-overlapping paths for AFL/PFL monitoring.

Output and Send Assignments May Not Reactivated if They Are Disabled and Then Re-enabled in the 10 Setup when DSP Usage
is at its Maximum (PTSW-156397)

Disabling and re-enabling an internal or mapped bus in the IO Setup does not guarantee that all associated assignments will be
re-activated in a session that is using maximum DSP resources. To re-activate these assignments, save and reopen the session.
You can also avoid this issue by adding additional HDX cards to your system.

File and Disk Management
Missing Files when Opening a Session that Was Saved Using Save Copy In with Preserve Folder Hierarchy (PTSW-52860)

The Preserve Folder Hierarchy feature is designed so that sessions with media split between multiple volumes can be easily moved
between systems while retaining folder hierarchy. In order for media files to be automatically found, manually copy or create a
folder at the root level of each volume with the session name that contains the Audio Files or Video Files folder. Or, manually
relink to the missing files at their current location.

Session Copy Saved with Preserve Folder Hierarchy in which Multiple Files Have the Same Name Does Not Relink Properly
(PTSW-29069)

When saving a session copy with Preserve Folder Hierarchy checked, files with the same name may not relink properly when us-
ing Manual Relink. When opening the session copy, use Automatically Relink to locate the correct files. If the session has already
been opened using Manual Relink and some files are still offline, select Relink Offline in the Project Browser to manually relink
the remaining files.
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Elastic Audio

When Opening Legacy Sessions (Pro Tools 9 and Lower) in Pro Tools 10, Any Rendered Elastic Audio Clips Are Automatically
Re-rendered (PTSW-139989)

Rendered Elastic Audio clips created in legacy sessions need to be re-rendered for use in Pro Tools 10. Re-render of these files oc-
curs automatically when the session is opened in Pro Tools 10.

Fades on Elastic Audio-Enabled Tracks May Not Regenerate when Opening Sessions Created with Pro Tools 10 in Pro Tools
9.0.x (PTSW-152949)

When saving a copy of a Pro Tools 10 session to v7-v9 and opening the copy in Pro Tools 9.x, some fades might not be regenerated
even if you select the option to re-generate fades without searching. If this happens, closing and re-opening the session causes the
missing fades to regenerate.

Certain Audio Files Cannot Be Calculated or Cleared of Elastic Analysis in Workspace Browser (PTSW-29622)

There are some rare cases where a file will have a file suffix of a file format supported by Elastic Audio (either WAV or .AIF), but
the Pro Tools Workspace Browser will not allow calculation or clearing of elastic analysis. The browser menu items Calculate
Elastic Analysis and Clear Elastic Analysis will be greyed out. In these cases, the file may actually be in a non-supported format.
To check the file’s format, look at the Format column in the Workspace browser. If a file format other than WAV or AIFF is shown
(such as QuickTime), then the file cannot be calculated or cleared of elastic analysis. Note that these non-supported files can still
be previewed in tempo, as well as elasticized once imported into a session.

Tempo Maps Made from Bar|Beat Marker Generation in Beat Detective Cause Clip Groups in Rendered Mode to Fall Offline
(PTSW-34950)

A tempo map made from Bar|Beat Marker Generation in Beat Detective will cause clip groups in Rendered mode to fall offline.
The workaround is to make an edit to the offline clip and then toggle the Elastic Audio from rendered to real-time and then back
to rendered.

Maintaining Phase Coherency with Elastic Audio Pitch Processing (PTSW-20602)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Mono-
phonic or Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio Pitch
processing from the track before switching to the Monophonic or Varispeed algorithm.

Drift in an Audio File May Occur when Using Elastic Audio and the Monophonic or X-Form Algorithms (PTSW-33768)

Drift in an audio clip may occur when using elastic audio depending on how much the clips is expanded or compressed when us-
ing the Monophonic or X-Form algorithms. If you are using elastic audio with material that contains transient information in it
that you would like to keep from drifting, you should use the Polyphonic or Rhythmic algorithms.

Default Input Gain Preference Is Only for Elastic Audio Imported at Session Tempo (PTSW-34096)

The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported
at Session Tempo only. This preference option will not function unless Preview in Context is enabled in Workspace, and/or “Drag
and Drop from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.

Displayed Timebase is Incorrect after Importing Elastic Audio Tracks (PTSW-46897)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will need
to manually select the correct timebase for the affected tracks.

Elastic Audio Clips on Playlist Lanes Are Not Rendered (PTSW-47311)

In Playlists View, any Elastic Audio clips on Playlist lanes are not rendered (waveform is “off-line”) when changing the track’s
Elastic Audio processing from Real-Time to Rendered.
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Clip Groups Containing Elastic Audio Are Not Recognized as Elastic if the Clip Group Itself Has Not Had Any Elastic Functions
Applied (PTSW-34335)

If a clip group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level of the
clip group itself, then the clip group will not register as Elastic Audio. When used to create a new track, the track will not auto-
matically be Elastic Audio-enabled, and the elastic audio inside the clip group will be rendered using the default Elastic Audio
plug-in for the session. As a workaround, add a warp marker to the clip group to force it to register as an elastic clip. Or, create
an Elastic Audio-enabled track first, then add the clip group to it.

Cannot Import Elastic Audio Tracks with the Consolidate From Source Media Option (PTSW-33894)
Use Copy from Source Media to import Elastic Audio tracks.

Timing Inaccuracy in Audio Files Converted from CAF and MP3 with Preview In Context Enabled (PTSW-46707)

Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio and
inner-clip asynchronous transients issues). This is inherent with compressed file formats.

MIDI
When Recording MIDI, Wait for Note Does Not Respond to MIDI Input from ReWire (PTSW-30511 and PTSW-34550)

When performing a MIDI record, Wait for Note will not respond to any MIDI received from ReWire. If you are recording MIDI
generated from a ReWire application, you will have to start the transport manually or use a countoff instead of Wait for Note.

When Using Import Session Data on a MIDI Track with Real-Time Properties Enabled and Set to Using Diatonic Transposition,
Transposition is Based on the First Key Signature in the Session Only (PTSW-49297)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the
“Transpose in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can be
corrected by toggling the Real-Time Properties off and on; then the diatonic transposition will be correct for each key.

Plug-Ins
For known issues about specific plug-ins, see the Audio Plug-Ins Read Me.

On Mac OS X 10.7.x (“Lion”), Any Custom Location for Avid Virtual Instrument Content is not Remembered

When installing Avid Virtual Instruments, if you choose a custom location for the content, that location is not remembered, re-
sulting in error messages when you try to use a virtual instrument plug-in (Boom, Mini Grand, or Xpand) that references a “.big”
content file. The location is not remembered after quitting and relaunching Pro Tools.

To avoid this error, move or reinstall the Avid Virtual Instrument content to the default location in the Applications > Avid
folder.

Some Plug-ins Require Exclusive Use a DSP Chip on HDX Hardware Accelerated Systems (PTSW-154614)

Certain plug-ins, such as ReVibe and Reverb One, use direct memory access (DMA) on Avid HDX cards. DMA plug-ins cannot
share HDX DSP chips with other plug-ins. Additionally, even though DMA plug-ins of the same type can share a single HDX DSP
chip (for example, multiple ReVibe plug-ins can use the same HDX DSP chip), they must be of the same channel width (DMA
plug-ins of the same type cannot share the same HDX DSP chip if they have different channel widths).

HD Pack, Massive Pack, Mbox Factory, and 003 Factory Plug-in Bundle Installers Do Not Work on Pro Tools 9.0 or Higher
Systems (PTSW-134351)

If you install Pro Tools 9.0 or higher on a clean Pro Tools system, and then run HD Pack, Mbox Factory, or 003 Factory plug-in
installers included with lower versions of Pro Tools (such as Pro Tools 8.0.4), they will not be able to install the bundled plug-

ins as you might expect. Visit the Avid website (www.avid.com) to download the latest versions of corresponding installers in-

cluded with the version of HD Pack, Massive Pack, Mbox Factory, or 003 Factory that you own. These installers have been updated
to run on a Pro Tools 9.0 or higher system (as long as you have valid licences for each plug-in on your iLok).
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Pro Tools Hangs when Opening a Session with Structure Free (PTSW-131965)

When opening a Pro Tools session that uses Structure Free, Pro Tools may hang temporarily if Structure Free is looking for files
in a directory where the files are not present.

Pro Tools Quits Unexpectedly when Creating a New Folder on the Presets Page with Hybrid (PTSW-133279)

When using Hybrid version 1.5.3.10110, Pro Tools may quit unexpectedly when using the New Folder feature on the Presets page.
To avoid this problem, update to the latest version of Hybrid.

AudioSuite and Clip Groups (PTSW-57457)

AudioSuite plug-ins handle Clip Groups in the Clip List slightly differently than audio files. With audio files, an AudioSuite pro-
cess can be applied to all copies of a unique audio file which appear in your session by selecting your target as Clip List in the Au-
dioSuite plug-in window and selecting Use in Playlist. However, if your target is set to Clip List in the AudioSuite plug-in window
while you have a Clip Group selected, Pro Tools does not recognize the Clip Group as processable audio and will present a No Au-
dio was Selected error. This is because a Clip Group is not treated as audio until it is actually used in a track.

To apply an AudioSuite process to all copies of a Clip Group in a session at once, do the following:

1 Select the Clip Group to be processed.

2 From the Clip List menu, select Ungroup All. All elements of the group will remain selected.
3 Perform AudioSuite processing.

4 From the Clip List menu, select Regroup.

5 When prompted, select Modify to apply the AudioSuite Process to all copies of the Clip Group in the session, or Copy to apply
it only to the selected Clip Group.

Plug-in Find and Relink with File Types not Supported by Pro Tools (111704)

Find and Relink will not be triggered by plug-ins in situations where plug-ins supporting Find and Relink are missing links to file
types that are not natively supported by Pro Tools (such as REX files). To have full Plug-in Find and Relink support, the file types
used in plug-ins must also be supported by Pro Tools.

Software Instrument Does Not Emit Sound when Inserted on an Instrument Track or Auxiliary Input (65797)

Some older software instruments do not emit sound and/or do not play unless they have a valid hardware input or MIDI output
assignment. If this problem occurs, manually assign a hardware input to the Instrument track or Auxiliary Input, and/or manu-
ally assign a MIDI output to the Instrument.

After Installing Pro Tools 10, Structure Free Appears in the Plug-in Insert Selector Instead of the Full Version of Structure Even
Though the Full Version of Structure was Already Installed (PTSW-150093)

After installing Pro Tools 10 Structure Free appears in the Plug-in Insert selector instead of the full version of Structure even
though the full version of Structure was already installed on your computer. To correct this issue, quit Pro Tools, delete the DAE
preferences located in /Users/<username>/Library/Preferences/DAE Prefs, and then relaunch Pro Tools.

Using the Pro Tools 9.0.5 Uninstaller Also Uninstalls Structure (PTSW-151154)

When using the Pro Tools 9.0.5 Uninstaller to uninstall Pro Tools 9.x, the Structure plug-in is also uninstalled from your com-
puter. To avoid this issue, do not use the Pro Tools 9.0.5 uninstaller (you do not need to uninstall Pro Tools 9.x before installing
Pro Tools 10). If you encounter this issue, you will need to reinstall Structure after you install Pro Tools 10.

Pro Tools Quits Unexpectedly when Canceling BX Digital PACE Authorization (PTSW-132311)

If Pro Tools quits unexpectedly when canceling the PACE authorization for BX Digital plug-ins, be sure to install the latest iLok
driver (even if the driver is already installed). This should correct the problem.
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Control Surfaces
Trim Scrub and Trim Shuttle Don’t Work on Clips with Fades (PTSW-46911)

If a clip has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around this prob-
lem, remove any fades on the clip, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.

Used HW Output Path Indication (101095)

In Assign Matrix on your worksurface, Insert mode the used HW output path will not have amber background indicating that it's
already assigned after switching to a different insert on the same track.

Color Indication on Plug-in Controls in Learn Mode (102710)

When a plug-in is in Learn mode and the track with this plug-in is not focused on the main ICON unit, all automation LEDs in
the Plug-in window will be red if the track is in one of auto write modes. This conflicts with red color indication on the Plug-in
control, which is armed for mapping. The workaround is to set the track with plug-ins to Read automation mode.

SignalTools Meter Ballistics on Control Surfaces (74340)

SignalTools RMS, VU, BBC, Nordic and DIN meters will display inaccurate decay times when viewed on a control surface. Unaf-
fected types are Peak, VENUE, and Peak + RMS, which only reports the Peak meter to the control surface. The attack times of the
affected meters are not affected, only the decay times. All meter types display accurately in the plug-in window.

Channel Strip Plug-in Expander/Gate Meters Appear in the Compressor/Limiter Meter Instead of in the Expander/Gate Meter in
D-Control Dynamics Section (Main Unit) (PTSW-150897)

The Avid Channel Strip plug-in uses shared meters for Expander/Gate and Compressor/Limiter processing. Because of this, both
Expander/Gate and Compressor/Limiter metering appear only in the Compressor/Limiter meter in D-Control Dynamics Section
(Main Unit).

Pro Tools Transport Must Be Stopped when Recalibrating ICON Faders (78074)

The transport in Pro Tools must be stopped when recalibrating faders on D-Command and D-Control. If one or more faders need
calibration do the following: Stop playback, enter Utility mode, press TEST, press FADER, and press RECAL. After recalibrating
faders. exit Utility mode.

Adjusting Clip Gain with the Jog Wheel on a EUCON Control Surface can Result in Pro Tools Quitting Unexpectedly
(PTSW-155028)

Adjusting Clip Gain using the Jog Wheel on a EUCON control surface during playback can result in Pro Tools quitting unexpect-
edly. You can avoid this issue by using the mouse or key commands to adjust clip gain instead.

The Edit and Mix Window Do Not Follow Banking on EUCON Control Surfaces (PTSW-133466)

When the Edit Window Follows Bank Selection and/or the Mix Window Follows Bank Selection preferences are enabled in

Pro Tools (Setup > Preferences > Mixing), after banking your EUCON controller, neither the Edit nor Mix window scroll to fol-
low. You will have to manually change the view of the Edit or Mix windows to see the tracks that correspond to the EUCON con-
troller if they are off screen.

Switching applications in Mac OS X 10.7.x (Lion) while using a EUCON control surface can cause Pro Tools to stop working
(PTSW-152800)

On a system running Mac OS X 10.7.x (Lion) with a EUCON control surface, if you are running other applications with Pro Tools,
switching Pro Tools to the frontmost application can cause it to stop working. To prevent this, lock the surface to Pro Tools by
doing the following: In the EuControl application, click the Assign tab. Under EuControl Settings, select “Entire Surface” under
“Lock to application” and verify that the control surface is locked to Pro Tools.
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Video
Avid Video Peripherals Are Not Officially Supported with Pro Tools Software (PTSW-132918)

When using an Avid video peripheral such as Mojo SDI with Pro Tools, you must have Pro Tools|HD or HD Native hardware with
a SYNC HD or SYNC IO in order to maintain near sample accurate audio/video sync. Alternately, Pro Tools LE hardware contain-
ing an S/PDIF input can be used to resolve the audio clock to the video peripheral. While it is possible to use an Avid video pe-
ripheral without the presence of any hardware (Pro Tools Software only), audio/video sync is not guaranteed.

Video Offset Affects Bounce To QuickTime Files (PTSW-123033)

If Pro Tools has a defined Video Offset and you Bounce to QuickTime, the resultant QuickTime file will be offset by the specified
amount in Pro Tools (Setup > Video Sync Offset). To avoid this problem, set the Video Sync Offset to 0 before bouncing to the
QuickTime file format.

QuickTime Movies with a Frame Rate of 29.97 and Greater that Use the Avid DNxHD Codec Do Not Play when Placed at Past
20 Hours Down the Pro Tools Timeline (PTSW-149397)

With Pro Tools 10, the timeline has increased from 12 hours to 24 hours, allowing any timecode stamped media to be placed at
its Original TimeStamp location, regardless of the session start time. However, Avid DNxHD encoded QuickTime clips will not
play back when placed anywhere on the Timeline past 20 hours. Please limit use of Avid DNxHD encoded QuickTime clips to the
first 20 hours of the Pro Tools Timeline to avoid this issue.

When Using Bounce to QuickTime, Do Not Bounce to an Existing Movie Name (PTSW-53967)

If you use the Bounce to QuickTime command and use the same name as an existing movie, the bounce may fail. It is best to use
a unique name for each bounce, or delete the previous movie from the drive prior to bouncing with the same name (rather than
choosing to replace the existing file).

Pro Tools Ul May Slow Down with Densely Edited QuickTime Movie Track (PTSW-54496)

Pro Tools may begin to respond more slowly and update less often as a session with one or more QuickTime video tracks becomes
more and more densely edited. If, while working with heavily edited QuickTime clips, Pro Tools responsiveness begins to decline,
use the Bounce to QuickTime Video command, then import the bounced movie.

Unsupported QuickTime Video Formats (PTSW-52140, PTSW-52155, PTSW-52156, 72961)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format
movies. Attempting to import these will generate errors or will fail to import.

QuickTime Clips with “Clean Aperture” Settings Do Not Play Back in Pro Tools 10 on OS X 10.7 (PTSW-150342)

Pro Tools 10 on Mac OS X 10.7 is unable to playback QuickTime video clips with “Clean Aperture” settings. The session plays
back, but these clips appear black in the Video window. These clips do play back in Pro Tools 10 on Mac OS X 10.6.

Standard Definition QuickTime Movies Are Rendered as 16:9 Anamorphic Play Back in Pro Tools at 4:3 (PTSW-23020)

Standard Definition QuickTime movies rendered with 16:9 an anamorphic Scaled Size of 853x480 play back in Pro Tools at 4:3 or
720x486 resolution. The Scaled Size attribute of QuickTime movies is ignored by Pro Tools. To work around this problem, render
the movie letterbox natively within the 720x486 pixel dimension.

MPEG-1 and MPEG-2 Video Freezes at Edit Points (PTSW-55185)

Editing MPEG-1 & MPEG-2 video is not officially supported. If you experience this problem, try switching playback to the Video
window, or convert the movie to a supported format using a 3rd party application. Removing the audio from an MPEG-1 or
MPEG-2 movie with a 3rd party application may also fix the problem.
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Audio from “Muxed” MPEG-1 and MPEG-2 Movies Cannot Be Imported and Will Be Heard in a Bounced Movie (PTSW-53625)

Unlike other QuickTime formats, MPEG-1 and MPEG-2 movies store audio and video in a single multiplexed track, called a
“muxed.” track. Pro Tools cannot separate the audio from video for these types of movies. As a result, you will not be able to im-
port the audio from an MPEG-1 or MPEG-2 movie. Also, if you Bounce to QuickTime using an MPEG-1 or MPEG-2 movie as a
source movie, the original audio from the movie will be present in the bounced movie (even though it will not be heard while
working with the movie in Pro Tools). To import audio from an MPEG-1 or MPEG-2 file, use a third party application to “demux”
the MPEG stream.

Dragging from Mac Finder in Shuffle Mode Does Not Work Correctly with Video (PTSW-28041)

Dragging a Video file from the desktop to the Edit window while in Shuffle mode will always place the video at session start, over-
writing existing video clips in that location.

System Instability when Running Multiple Applications Using Blackmagic Design Hardware for QuickTime Video Output
(PTSW-19486)

When Pro Tools is running with a Blackmagic DeckLink II Extreme or Intensity video capture and playback PCI-e card installed,
launching Blackmagic Design’s Deck Capture utility, Final Cut Studio, or any other application which supports Black Magic hard-
ware for video output, can result in system instability. To avoid any potential system instability only use one Blackmagic Deck-
Link-aware application at a time.

Clip names appear incorrect after selecting Field Recorder channel matches, or expanding to new tracks.
(PTSW-136012)

This can occur if the file name of a Field Recorder channel match contains a hyphen followed by a number greater than zero. Pro
Tools names new clips by incrementing the number after the hyphen. If a field recorder file is already named in this way (such
as “Filename-017), then new clips created by selecting a Field Recorder channel match or by expanding a track may have names
different from the parent file. To avoid this situation, avoid using hyphens in Field Recorder file names.

Importing a File Directly to a Field Recorder Guide Track Disables the Field Recorder Guide Track Setting (PTSW-152913)

Importing an audio file directly to a Field Recorder Guide track, either by dragging from the Workspace browser or dragging from
the desktop, will disable the Field Recorder Guide track setting for that track. Once this has occurred, you must re-enable the
track as a Field Recorder Guide track. To avoid this issue, import the file to the Clip List first, then drag it to the track. Alter-
nately, you can use the Import Audio command (File > Import Audio) to import the file to a new track or the Clip List, and then
drag it to the desired track.

Field Recorder Matches Appear Offset After AudioSuite Rendering if the Session Timecode Rate Does not Match the File
Timecode Rate (PTSW-152147)

If a portion of a file has been rendered with an AudioSuite plug-in, an offset can occur when expanding field recorder matches
in cases where the session timecode rate does not match the timecode rate of the audio file. To avoid this issue, you can either ren-
der the whole file with AudioSuite (rather than only a portion of the file), or use Whole File mode when rendering AudioSuite pro-
cessing.

General Localization

Session Notes or Session Info Text Files Saved in Japanese May Not Open in TextEdit (PTSW-46686)

Session Notes (you can generate these if you are missing plug-ins or have problems when opening a session) or Session Info (File
> Export > Session Info as Text) text files may not open in TextEdit, depending on the TextEdit preference settings. This is be-
cause the files use different text encoding. As a workaround, you can use the Console application to open files or you can use the
Open menu item in TextEdit, then choose the correct encoding, as follows:

o Session Notes - UTF-8

« Session Info - Japanese (Mac OS)

Reading Session Notes on Korean Mac OS X (PTSW-144218)

Apple has changed its default UTF-8 encoding behavior in the latter 10.6.x releases and 10.7.x. Because of this some languages do
not open Session Notes correctly in TextEdit.
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To open Session Notes correctly:

1 Launch TextEdit.
2 Choose TextEdit > Preferences.
3 Click Open and Save.

4 Under “Plain Text File Encoding,” set Opening Files to Unicode (UTF-8).

Certain Chinese Characters Need to Be Initiated in the Mac OS Before They Can Be Used for Naming in Pro Tools (PTSW-33074)

If you cannot use certain characters for naming in Pro Tools, use Text Edit in Mac OS X to initiate the characters. In Text Edit,
type the same characters you were trying to use, then use the mouse to select the correct ones from the pop up menu. You should
now be able to use them in Pro Tools.

AAF/OMF Sequences with Non-English Characters Import with Garbled Clip Names or Won't Relink (PTSW-33569, PTSW-
99570, PTSW-33826)

If an AAF/OMF sequence containing files or clip names with non-English characters is exported from a Mac-based Pro Tools 7.3.1
system (or lower), it may not import correctly into Avid Media Composer, or Pro Tools 7.4 and higher systems on Windows or
Mac. Conversely, AAF/OMF sequences with non-English characters exported from any Pro Tools 7.4 or higher system (or higher)
may not import correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the files, select “Manually Find and
Relink,” then deselect all options except “Find by file ID.” Clip names may appear garbled.

Known Issues with Pro Tools CoreAudio Hardware Drivers
Limitations of the Avid CoreAudio Driver with Digi CoreAudio Manager
The Digi CoreAudio Driver has the following limitations with HD, 003, and Digi 002 systems:

Pro Tools HD, and Pro Tools with 003 and Digi 002 systems require exclusive access to Pro Tools hardware. You cannot use Core-
Audio applications and Pro Tools with these systems at the same time. To use Pro Tools, make sure you quit any CoreAudio ap-
plications before launching Pro Tools on these systems. To use a CoreAudio application with these systems, make sure you quit
Pro Tools before starting the CoreAudio application.

+ The Digi CoreAudio Driver cannot be used to preview sound files from the Mac Finder while Pro Tools is running. When a sound
file is located in the Mac OS X navigation window, a QuickTime transport bar is displayed next to it. The QuickTime transport bar
lets you audition the sound file. With USB audio interfaces, you can preview sound files from the Mac Finder as long as Pro Tools
is not running. Regardless, with FireWire and Avid HD audio interfaces, the sound will always play back though the Mac built-in
audio controller (through the Mac speaker or headphone jack). However, if you double-click a sound file, the QuickTime applica-
tion will launch, which can use the Digi CoreAudio Driver for playback.

The Digi CoreAudio Driver cannot be used for playback of Mac System Sounds.

Selecting “Digidesign HW” for Sound Input or Output in System Preferences May Cause Pro Tools to Fail to Launch (99576)

If “Digidesign HW” is selected as the input or output device in System Preferences, certain common actions in the Finder may ac-
tivate the Digi CoreAudio Manager. These actions include selecting an audio or video file while in Columns view or while the In-
spector window is open, or using Get Info or Quick Look on an audio or video file. Once activated, CoreAudio may remain con-
nected even after selecting a different file or closing all Finder windows. If Pro Tools is launched while CoreAudio is connected,
an error message stating “Digidesign Hardware is in use by another application. (-1133)” may occur.

Pops when Changing Sample Rates

With the Digi CoreAudio Manger, your Pro Tools hardware may produce a “pop” or “click” sound if Pro Tools was last used at a
sample rate different from the one the new CoreAudio client is set to use.
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Pro Tools Hardware May Not Play Sound from QuickTime or Safari with CoreAudio (PTSW-3093 and PTSW-27892)
If you do not hear sound when playing back audio through Pro Tools hardware from QuickTime or Safari with the Digi CoreAu-
dio Manager, try one the following:

« Open the Mac System Preferences and click Sound. While QuickTime or Safari is playing back audio, change the Output from
Digidesign HW to Internal, and then back to Digidesign HW.

— or —

o Launch iTunes before launching QuickTime or Safari.

Buffer Sizes Incompatible with Pro Tools Hardware (39542)

In Cubase, Traktor, Live, and certain other applications, you can select Buffer Sizes that may be incompatible with your Pro Tools
hardware. Selecting incompatible buffer sizes results in distorted sound and may cause other problems. Please make sure to select
Buffer Sizes listed in the following chart:

Cubase SX Buffer Sizes Supported by Avid Audio Hardware

Avid Audio Hardware Supported Buffer Sizes
Avid HDX 128, 256, 512, 1024
Pro Tools|HD 128, 256, 512, 1024
HD Native 128, 256, 512, 1024

003, 003 Rack, 003 Rack+, Eleven Rack, Digi 002, | 64, 128, 256, 512, 1024
and Digi 002 Rack

Mbox and Mbox 2-series interfaces 32, 64, 128, 256, 512, 1024

Reason Output Distorts with Buffer Size Settings Less than 256 Samples, at 88.2 kHz or 96 kHz (39399)

Distorted sound can result when a Reason user has selected a Buffer Size of less than 256 samples at sample rates of 88.2 kHz or
96 kHz.

Known Issues with Audio Interfaces

HD OMNI
Noise in the Output Signal from HD OMNI with Digital Input (PTSW-1614)

If HD OMNI is connected to a digital source with a mismatched clock and Sample Rate Conversion (SRC) is not enabled, you will
hear noise (including loud “pops”) in the output signal. To correct this problem, either enable SRC or ensure that the clock of the
digital source and HD OMNI are matched correctly.

HD OMNI Front Panel SETUP Menus are Unresponsive after Pro Tools Quits Unexpectedly (PTSW-125692)

HD OMNI will not automatically recover “stand-alone” mode if Pro Tools quits unexpectedly (or if you disconnect the DigiLink
cable from HD OMNI while Pro Tools is running). As a result, some of the SETUP functions accessible from the front panel will
be unavailable. Power cycle HD OMNI to recover stand-alone mode.

Graphic Redraw Problems in the Hardware Setup Dialog (PTSW-122690, PTSW-1346, and PTSW-1235)

When changing the Hardware Setup configuration for HD OMNTI, it is possible to encounter graphics redraw problems in some
cases. To force a graphics redraw of the Hardware Setup dialog, close and reopen the Hardware Setup dialog.

Versions of Pro Tools Lower than 8.1 Quit on Launch with HD OMNI (PTSW-1976)

When launching versions of Pro Tools lower than 8.1 with HD OMNI connected and powered on, Pro Tools quits when initializing
DSI. To avoid the problem, power off HD OMNI before launching versions of Pro Tools lower than 8.1.
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No Sound on Output after Hardware RESET (PTSW-126575)

After resetting the HD OMNI interface to the default factory settings using the front panel controls, the HD OMNI interface stops
emitting sound in sessions where the outputs are not assigned to the Monitor output path. To correct this problem, press the ALT
monitor button to switch to the ALT Monitor path, and then press it again to switch back to the Main Monitor path.

Loss of Monitor Path when Launching Pro Tools with HD OMNI Off or Disconnected (PTSW-127313)

When launching Pro Tools and opening I/O Setup after powering off HD OMNI or disconnecting it from the system, the inactive
Monitor path is not present in Output tab. You may need to restore the default I/O Settings and remap the corresponding Output
Busses.

Output Paths are not Automatically Created in the Output Page of the I/O Setup After Disabling the Corresponding Monitor Path
in the Monitor Page of the Hardware Setup and Re-assigning the Outputs from “None” to Physical Outputs in the Main Page of
the Hardware Setup (PTSW-127559)

After disabling the Monitor path in the Monitor page of the Hardware Setup and re-assigning the corresponding Outputs from
“None” to physical outputs (such as “A 1-2”) in the Main Page of the Hardware Setup, these Output paths are not automatically
created in the Output Page of the I/O Setup. You will have to manually create the appropriate Output paths in the I/O Setup (or
click Default).

Changing Monitor Path Output Assignments in the Hardware Setup does not Update the Output Paths in the Output Page of the
I/O Setup (PTSW-127563)

When changing Monitor path Output assignments in the Monitor page of the Hardware Setup (such as setting the Monitor path
Format to None or assigning the Monitor to different physical outputs), the Output paths in the Output page of the I/0 Setup do
not reflect the corresponding changes. You will have to manually create the appropriate Output paths in the I/0 Setup (or click
Default).

When Creating New Sessions, Using the I/O Settings Selector Can Result in Unexpected Output Assignments if HD OMNI Has
an Assigned Monitor Path (PTSW-123896)

If HD OMNI has an assigned Monitor path, Output paths created by the selected I/O Settings option in the New Session dialog may
be offset by the channel width of the Monitor path. If this happens, you will have to manually create the appropriate Output paths
in the I/0 Setup (or click Default).

I/O Setup Bus Page Erroneously Adds Monitor Paths (PTSW-127739)

With both MAIN and ALT Monitor paths declared, toggling one of the CR Monitor paths from the current format to “None” and
then back to the starting Monitor format from within the Hardware Setup Monitor page, causes the Bus page in I/O Setup to er-
roneously add an extra Monitor path with the abbreviation with “(1).” This can happen numerous time and each new Monitor ab-
breviation increments accordingly.

Pro Tools Aggregate 1/O (Mac Built-In Audio)

When using Aggregate I/O on Mac OS 10.7.x (“Lion”), a New Session command results in an error (PTSW-142151) or the
Aggregate I/O Sample Rate is frozen at a setting of 0 Hz (PTSW-142166)

If either of these errors occurs, do the following:

1 Quit Pro Tools.

2 Launch Audio MIDI Setup.

3 Choose Window > Show Audio Window.

4 Select Pro Tools Aggregate 1/0.

5 Click the Minus sign icon to delete Aggregate I/0.

6 Relaunch Pro Tools.
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—6101 Error When Previewing Audio with Pro Tools Aggregate I/O (PTSW-132996)

When previewing audio in the Import Audio dialog with Pro Tools Aggregate I/0 selected as the Current Engine (in the Playback
Engine dialog), and with the Mac OS File view is set to Columns view, you may encounter a -6101 error. Try changing the Mac
0S file view from Columns to List or Icons view, or use any of the built-in audio devices instead of Pro Tools Aggregate 1/0 to
avoid this problem.

Changing Sample Rates in Audio MIDI Setup can cause Aggregate I/O to Disappear in I/0O Setup, Resulting no Audio Output
(PTSW-132281)

When Pro Tools Aggregate I/0 is selected as the Current Engine in the Playback Engine dialog, changing sample rates in Audio
MIDI Setup can cause the Pro Tools Aggregate I/0 to be removed from I/O Setup resulting in no audio output. To correct this
problem, click the Default button on the Output page of the I/O Setup.

Error Messages When Opening a Session with a Different Sample Rate from the Aggregate I/O Sample Rate Setting
(PTSW-131779)

Pro Tools may indicate that a given Aggregate I/0 device has not automatically adjusted its sample rate when a session with a dif-
ferent sample rate is opened. You may subsequently be presented with a dialog indicating that the session needs to be closed and
reopened to update the sample rate setting of the Aggregate I/0 device.

Renaming Pro Tools Aggregate I/O driver in AMS Corrupts the Driver (PTSW-131383)

If you rename the Pro Tools Aggregate I/0 driver in Audio MIDI Setup (AMS), the driver be corrupted the next time you launch
Pro Tools. If this happens, quit Pro Tools and delete the Pro Tools Aggregate I/0 device from AMS. Pro Tools will re-create the
driver the next time it is launched.

Pro Tools Quits Unexpectedly when Enabling the Built-In Digital I/O (PTSW-132189)

When enabling built-in digital I/O for Pro Tools Aggregate I/0 in Audio MIDI Setup, Pro Tools quits unexpectedly. To avoid this
problem, enable the built-in digital I/O in Audio MIDI Setup before launching Pro Tools.

Third-Party Core Audio Devices

Pops and Clicks can Occur when Using Third-Party Core Audio Devices with Pro Tools (PTSW-132084)

Note that audible pops and clicks can occur when using some third-party audio interfaces even if Error Suppression is disabled.
Try increasing the Hardware Buffer size for the device to avoid this problem.

Using Low Buffer Sizes with Studio Monitor Express may Resultin Pro Tools Quitting Unexpectedly with a Loud Burst of Noise
(PTSW-132513)

Using Studio Monitor Express with some Core Audio Devices may result in Pro Tools quitting unexpectedly along with loud
bursts of noise. Studio Monitor Express is not recommend for use with Pro Tools at this time.

Error Messages
Error —1150 (PTSW-144422)

When launching Pro Tools HD on HDX hardware, if you encounter a -1150 error, quite Pro Tools, shut down your computer, and
ensure that the HDX TDM cable is properly connected.

Error —6042

If you repeatedly encounter —-6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you

will need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a -6042 er-
ror, quit and relaunch Pro Tools, open the Playback Engine dialog, and change the Number of Voices setting to use fewer voices
per DSP.
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Error —-9073 Without Reaching the 2 GB File Limit

If you encounter a -9073 error, and you have not reached the 2 GB file size limit, please refer to the Knowledge Base for possible
causes and solutions (www.avid.com/onlinesupport).

Error —9092

When using MachineControl to control a 9-pin device, you may encounter a -9092 error if the machine is cued to a point before
session start. Adjust session start of sessions used with the 9-pin client to accommodate the necessary pre-roll for transport lock.

Error —9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid -9128
errors during playback with Native (RTAS and AAX) plug-ins or dense automation.

Error —-9131 (92747, 20843)

GUID partitioned drives will not allow you to record beyond the third partition when running on OS X. A workaround is to par-
tition audio drives using Apple Partition Map instead of GUID.

Recording to or playing from a UNIX File System (UFS) formatted drive is not supported in Pro Tools.

Error —9132 (32397)

If a -9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the appropriate
tracks to the appropriate number and format of audio tracks, and record to disk. You can then use the resulting audio files as you
would have used bounced files.

Error —9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid -9155
errors during playback with dense automation.

Error —9735

When Pro Tools reaches the end of its time limit in the session Timeline, or if Pro Tools has been in continuous play for longer
than the maximum time limit, you will encounter a -9735 error. The maximum time limit for Pro Tools depends on the session
sample rate. For more information, see the Pro Tools Reference Guide.
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